


Certification Prep Series
by D. Michael Ploor
Certification Prep Series consists of individual guides that provide practice in the 
basic skills needed to be successful using the corresponding software. No previous 
software experience is required. Although the guides focus on learning skills, not 
test taking, users that complete the practice will be prepared to take the official 
software certification exam and exhibit workplace readiness. Step-by-step instructions 
demonstrate actual software commands and features, building from basic to advanced. 
Content is divided into small units for better learning and usage. There is no need to 
purchase additional materials as all lesson content is created using the software.

•	 Provides an affordable way to prepare for industry certification versus other methods.
•	 Integrates easily into existing classroom activities.
•	 Focuses on hands-on experience to develop skills.

Start on Monday.
Test on Friday.

Microsoft Office Products
•	Microsoft Word 2013

•	Microsoft Excel 2013

•	Microsoft PowerPoint 2013

•	Microsoft Outlook 2013

•	Microsoft Access 2013

•	Microsoft Word 2010

•	Microsoft Excel 2010

•	Microsoft PowerPoint 2010

•	Microsoft Outlook 2010

•	Microsoft Access 2010

Adobe Products
•	Adobe Photoshop CS6

•	Adobe Dreamweaver CS6

•	Adobe Flash CS6

•	Adobe Photoshop CS5

•	Adobe Dreamweaver CS5

•	Adobe Flash CS5

To learn more, please contact your G-W Educational Consultant, 
visit www.g-w.com, or call 800.323.0440.
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Introduction
The Common Occupational Readiness Essentials (CORE) series of certifi cation 
preparation guides focuses on mastering the essential basic skills needed as 
a workplace-ready user of the software. The goal of each CORE certifi cation 
preparation guide is to provide practice in each essential basic skill required by 
employers who use the software. To prove workplace readiness, you will also be 
prepared to take the offi cial certifi cation exam for the software.

CORE Microsoft Outlook 2013 will help prepare you to take the Microsoft Offi ce 
Specialist (MOS) Microsoft Outlook 2013 certifi cation exam. It provides step-by-step 
instruction for the features and commands covered on the certifi cation exam. The focus 
of the lessons is to practice using the actual commands and features instead of creating 
a complete end product. All lesson content is created using the software. The only fi les 
that need to be downloaded are for the certifi cation simulation at the end of this guide. 
Furthermore, each certifi cation preparation guide is broken down into small learning 
units to enable better comprehension and application of the software. Where required, 
answers are provided at the back of the certifi cation preparation guide.

Certifi cation as a Microsoft Offi ce Specialist demonstrates an aptitude with 
Microsoft Offi ce software. MOS certifi cation is offered for Microsoft Word, 
Microsoft Excel, Microsoft PowerPoint, Microsoft Outlook, Microsoft Access, 
Microsoft SharePoint, and Microsoft OneNote. Certifi cation exams are provided by 
Certiport, Inc., through various testing facilities. Visit www.certiport.com for more 
information on registering for certifi cation exams.

About the Author
D. Michael Ploor is the author of the CORE series of certifi cation preparation guides. 
Mr. Ploor’s students have achieved exceptional results with the CORE certifi cation 
preparation guides. His students collectively pass more than 500 industry certifi cation 
exams each year without the need for other preparation materials. Mr. Ploor has 
demonstrated the strength of integrating the CORE guides in a diverse mix of courses.

Mr. Ploor is also the author of three textbooks on the subject of video game 
design: Introduction to Video Game Design, Video Game Design Foundations, and 
Video Game Design Composition. He is a National Board Certifi ed Teacher in Career 
and Technical Education and holds an MBA degree from the University of South 
Florida. He maintains professional teaching credentials in Business Education and 
Education Media Specialist.

Mr. Ploor is at the forefront of innovative teaching and curriculum. He developed 
STEM curriculum while serving as the lead teacher in the Career Academy of 
Computer Game Design at Middleton Magnet STEM High School. Mr. Ploor 
has applied his skills as a STEM Curriculum Integration Specialist in designing 
innovative curriculum and by collaborating to construct the state standards for 
video game design in several states. He has also been instrumental in authoring 
competitive events for Career and Technical Student Organizations such as the 
Future Business Leaders of America (FBLA) and Phi Beta Lambda (PBL). 

In addition to publishing textbooks and lessons, Mr. Ploor provides professional 
development as a frequent presenter at regional and national conferences to 
promote CTE education and video game design curriculum.
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Lesson 3
Contacts

Objectives
Students will create contacts in Microsoft Outlook. Students will edit contacts in 
Microsoft Outlook. Students will search Microsoft Outlook for contacts. Students 
will organize contacts in Microsoft Outlook. Students will edit contact groups in 
Microsoft Outlook.

Situation
Your new employer has asked you to set up your e-mail and contact information in 
Microsoft Outlook. The company needs you to be able to fully leverage Microsoft 
Outlook as a collaborative-communication tool. Before using and editing data in 
Outlook, the company has asked that you fi rst gather some resources to be used in 
setting up Microsoft Outlook.

Getting Started
 1. Launch Microsoft Outlook 2013.

 2. Click the New E-mail button in the New group on the Home tab of the ribbon. A 
new, blank e-mail message is opened in a new window. This window contains a 
ribbon, just like the main Outlook window.

 3. Click in the main text box of the e-mail message, and click the Online Pictures 
button in the Illustrations group on the Insert tab of the ribbon. The Insert 
Pictures dialog box is displayed, as shown in Figure 3-1.

 4. Click in the text box, and enter a search term such as face smile.

 5. Click the Search button to search for images.

 6. Scroll through the results that are displayed to locate an image that primarily 
shows a face, click the image to select it, and click the Insert button to place the 
image into the e-mail message.

 7. Right-click on the photograph in the e-mail message, and click Save as Picture… 
in the shortcut menu. A standard save dialog box is displayed.

 8. Navigate to your working folder, and save the photograph with your fi rst name 
as the fi le name.

 9. Applying what you have learned, save four additional face photographs. Name 
each fi le as the fi rst names of your friends.

 10. Close the e-mail message by clicking the close button (X) in the upper-right 
corner. When prompted, do not save or keep a draft of the message.

New E-mail

Online 
Pictures
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Creating Contacts
Contacts are the people that you regularly send and receive messages. Contacts are 
typically stored in a list or an address book. To start using Outlook, you will create 
some contacts that will be used later.

 11. Click the People link at the bottom of the screen to display the contacts view. 
Notice how some different commands are available in the ribbon.

 12. Click the New Contact button in the New group on the Home tab of the ribbon. 
The Contact dialog box is displayed, as shown in Figure 3-2.

 13. Click in the top text box next to the Full Name… button, and enter the name Red 
Miller. 

 14. Click in the Company: text box, and enter Fun Fruit for Food. Notice that 
a business card is created in the upper-right corner of the dialog box as 
information is entered.

 15. Click in the Job title: text box, and enter Owner.

 16. Click in the text box next to the E-mail… button, and enter Red@funfruitfood.xyz. 
Notice the Display as: text box is automatically fi lled in based on the e-mail and 
the name. It may take a few seconds for this to occur.

 17. Click in the text box in the Addresses area, enter 123 Mango Street, press the 
[Enter] key to start a new line, and enter Pineapple, PA  25599.

 18. Click in the text box next to the Business… button in the Phone area, and enter 
(555) 999-9001. When you press the [Enter] key or click in another text box, the 
Location Information dialog box is displayed, as shown in Figure 3-3. Note: if 
the location has already been set, this dialog box will not be displayed, in which 
case skip to step 20.

New 
Contact

Search termClick an image
to insert

Figure 3-1. 

Locating photographs from online pictures.
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 19. In the Location Information dialog box, click in the What area code (or city code) 
are you in now? text box, enter 555, and click the OK button. The Phone and 
Modem dialog box is displayed. Click the OK button to close this dialog box.

 20. Click the Add Contact Picture image tile, which currently shows a blank outline 
of a person. A standard open dialog box is displayed.

 21. Navigate to your working folder, select one of the images saved earlier, and 
click the OK button to add the image to the contact. Notice the image also 
appears on the business card. This is a very convenient way to remember 
people and make sure you are sending e-mails to the correct person.

 22. Click in the Notes text box below the business card. This is a great place to add 
information about the contact, such as personal information, people you both 
know, or why you typically contact this person. Add the following information.

Two kids: Betty and Joshua

Supplier of fruity treats for board meetings

Gives 15% discount for ordering fi ve days in advance

Business card

Mailing
address

Business
phone

number

E-mail
address

Subtitle

Company
name

Contact
name

Figure 3-2. 

Creating a new contact.
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 23. Click the Save & Close button to fi nish adding the contact. The business card 
for the contact is displayed in the middle of the contacts view. As contacts are 
added, their business cards will be displayed in this view.

 24. Applying what you have learned, add the contacts shown in Figure 3-4. Using 
the images saved earlier, add an image to each contact.

Editing Contacts
 25. In the contacts view, click the Phone button in the gallery in the Current View 

group on the Home tab of the ribbon. The contacts view changes to display the 
contacts in list form.

 26. In the Business Phone column, click the phone number for Malik Penny, and 
enter the new number of (555) 222-1234. You may need to click twice to make 
the phone number editable.

Save & 
Close

Phone

Enter an
area code

Click to display
this dialog box

Click to close
this dialog box

Figure 3-3. 

After location information is set up, these dialog boxes will not appear again.

Full Name Ray Tanaka Malik Penny Isabella Lopez Zoe Morales

Company Ray and Son Growers Shiny Penny Car Wash SpaceTech 
Manufacturing

Outlook Elementary 
School

Job Title Manager Repair Technician Loading Agent Grade 4 Teacher

E-mail Ray@rayson.xyz Malik@carwash.xyz Bella@spacetech.xyz Zoe.Morales@doe.xyz

Business 
Phone

(555) 333-0002 (555) 444-0005 (555) 777-0006 (555) 888-0007

Mailing 
Address

951 Fourth Street
Ellis, CA 23395

421 Washout Lane
Canyon, MS 23397

321 Blastoff Road
Rocket, FL 03398

8642 Even Avenue
Odd, MN 13579

Figure 3-4. 

Information to be used in creating new contacts.
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 27. Click the Business Card button in the gallery in the Current View group on the 
Home tab of the ribbon. The contacts view changes to display the business cards 
for the contacts.

 28. Double-click the business card for Zoe Morales. The Contact dialog box is 
displayed.

 29. Change her job title to Grade 5 Teacher.

 30. Close the Contact dialog box by clicking the Save & Close button to update the 
contact information.

 31. Applying what you have learned, add a note to the Zoe Morales contact 
information that states Conference period 12:00 to 1:00 daily.

Searching for Contacts
There are currently only a few contacts, but you may have hundreds of business 
contacts. Locating the correct contact could be very time-consuming. Fortunately, 
Outlook allows contacts to be located by searching for information.

 32. With the contacts view displayed, click in the text box in the Find group on the 
Home tab of the ribbon, as shown in Figure 3-5. This is a search text box.

Business 
Card

TIP
Double-clicking 
on a contact in any 
view opens the 
Contact dialog box, 
and the contact 
details can be 
edited.

TIP
The pop-up 
window displayed 
by hovering the 
cursor over the 
People link at 
the bottom of 
the screen can be 
used to search for 
contacts.

 33. Enter isa. Since there is only one contact that meets this search, a pop-up 
window is displayed containing information for Isabella Lopez as the [Enter] 
key is pressed. This pop-up window can be used to schedule a meeting, send an 
e-mail, or other task.

 34. Close the pop-up window by clicking the Close button (X) in the upper-right 
corner of the window.

 35. Enter the letter ma in the search box. This time, 
there are three matches: Malik Penny, Isabella 
Lopez (because of “manufacturing” in the 
company name), and Ray Tanaka (because 
his position is “manager”). In the list that is 
displayed, click the contact you wish to use, 
and the pop-up window is displayed for that 
contact.

 36. Applying what you have learned, search for the 
Zoe Morales contact, and display the pop-up 
window.

 37. Click the Edit link in the pop-up window. The 
window changes to allow edits. Click the Notes 
link in the pop-up window, add a note stating 
her birthday is August 14, and click the Save 
button to update the contact information.

 38. Close the pop-up window.

Organizing Contacts
Contacts can be categorized into a folder or group. A folder contains contacts and 
groups. Folders are also different address books. A group is a distribution list, which 
is a subset of your contacts. A group can contain contacts from several folders.

Enter a
search term

Figure 3-5. 

Searching for contacts.
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 39. Click the ellipses link (…) at the bottom of the 
screen, and click Folders in the shortcut menu. 
The folder list is displayed in the pane on the 
left of the Outlook window.

 40. Right-click on the Contacts branch in the folder 
list, and click New Folder… in the shortcut 
menu, as shown in Figure 3-6. The Create New 
Folder dialog box is displayed.

 41. Click in the Name: text box, enter Friends, and 
click the OK button to create the new folder. 
The folder is added under the Contacts branch 
in the folder list.

 42. Display business cards in the contacts view, and 
display the folder list.

 43. Click the business card for Zoe Morales, hold, 
drag it into the Friends folder in the folder list, 
and drop it. This moves the contact into the 
destination folder.

 44. Click the Friends folder in the folder list to verify 
the contact has been moved into the folder. 
The business card for Zoe Morales should be 
displayed in the middle of the Outlook window 
without any other business cards.

 45. Click the Contacts folder in the folder list to display its contents.

 46. Click and hold the business card for Ray Tanaka, hold the [Ctrl] key, and drag 
the card into the Friends folder. By holding the [Ctrl] key, the contact is copied into 
the destination folder. It remains in the Contacts folder as well.

 47. Click the Friends folder to display its contents and verify the business card is in 
the folder.

 48. With the Contacts folder open, click the New Contact Group button in the New 
group on the Home tab of the ribbon. The Contact Group dialog box is displayed.

 49. Click in the Name: text box, and enter Vendors.

 50. Click the Add Members button in the Members group on the Contact Group tab 
of the ribbon in the Contact Group dialog box, and click From Address Book in 
the shortcut menu. The Select Members dialog box is displayed, as shown in 
Figure 3-7. Notice only the contacts in the Contacts folder are displayed in this 
dialog box.

New Contact 
Group

Add Members

Right-
click

Click to create
a folder

Figure 3-6. 

Creating a new folder within the Contacts folder.

 51. Click Red Miller in the list of contacts, and click the Members button at the 
bottom of the dialog box. The contact name is added to the text box to the right 
of the Members button.

 52. Click Ray Tanaka in the list, and click the Members button to add him as a 
member of the group.

 53. Click the OK button to close the Select Members dialog box. The Vendors group 
being created now has two members listed.

TIP
To select members 
from a different 
location, click the 
Address Book 
drop-down list in 
the Select Members 
dialog box, and 
select the location 
in the drop-down 
menu.

TIP
The business card 
view may not be 
the default view for 
the Friends folder. 
Display business 
cards if needed.
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 54. Click the Save & Close button to fi nish creating the group. Notice a business 
card is added to the contacts view for the Vendors group, but business cards are 
also shown for the individual contacts who are members of the Vendors group.

 55. Applying what you have learned, create a new group named Customers that 
contains Malik Penny and Isabella Lopez.

Editing Contact Groups
Occasionally, you may to send a single message to several groups. Groups can be 
easily combined or joined in Outlook. It is just as easy to remove a contact from a 
group.

 56. In the contacts view, double-click the business card for the Vendors group.

 57. Applying what you have learned, add the Customers group as a member of the 
Vendors group.

 58. Save the Vendors group.

 59. Applying what you have learned, open the Customers group.

 60. Select the Malik Penny contact, and click the Remove Member button in 
Members group on the Contact Group tab of the ribbon in the Contact Group 
dialog box. The contact is no longer part of the group.

 61. Save the Customers group.

 62. Applying what you have learned, create a new contact folder named Me, and 
add a contact using your own information.

Save & 
Close

Remove 
Member

Click to select a
different location

Select a contact
and click to add

as a member

Contacts to be added

Figure 3-7. 

Selecting the members to be included within a contact group.
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Answers

Lesson 1
Activity 1-1

 1. Home

 2. File

 3. Send/Receive

 4. Folder

 5. View

 6. Home

 7. File

 8. Send/Receive

 9. Folder

 10. View

 11. Home

 12. Send/Receive

 13. Folder

 14. View

 15. Home

 16. Send/Receive

 17. Folder

 18. View

 19. Folder

 20. Home or Folder

 21. Send/Receive

 22. Home

 23. Folder

 24. File

 25. View

Activity 1-2

 1. Delete; deletes the selected item

 2. New Search Folder; creates a new folder for 
displaying search results

 3. Reverse Sort; reverses the sort order of the 
current view

 4. Forward; forwards the selected item to 
another recipient

 5. Process Marked Headers; downloads the 
content of all marked messages

 6. AutoArchive Settings; specifi es when the 
current folder will be archived

 7. Show Progress; shows the current send/
receive status

 8. Categorize; applies a category to the selected 
item

 9. Reply with Meeting; replies to the selected 
e-mail with a meeting invite

 10. Send/Receive All Folders; sends and receives 
all items in all folders

 11. Rename This Folder; renames the selected 
folder

 12. Change View; changes the current view to a 
different view 

 13. Add Columns; allows selection of which fi elds 
to display in the view

 14. Folder Properties; displays the properties of 
the selected folder

 15. Move; moves or copies the selected item to a 
different folder

 16. Junk; marks the selected item as junk or to 
allow it

 17. Mark All As Read; marks all messages in the 
current folder as read

 18. Reminders Window; displays the Reminders 
dialog box

 19. Reading Pane; shows or hides the Reading 
pane

 20. Filter E-mail; fi lters messages in the current 
folder
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